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About this Guide 

This document is an Installation Guide that describes how to install and 
configure Baan ERP 5.0c on a Microsoft Windows 2000 platform that runs 
Microsoft SQL Server. This document also describes how to install and 
customize the Microsoft SQL Server database management system for Baan 
ERP. 

This document is intended for Baan ERP installers and system 
administrators. The reader is assumed to be familiar with the system 
administration of Microsoft Windows 2000 systems. In addition, 
understanding the contents is easier if you are familiar with the structure of 
Baan ERP 5.0c with the following: 

� Package VRCs  

� Package combinations  

� Derived-from structure 

The purpose of this document is to help you set up a standard environment. 
For tuning information, refer to the Baan ERP Technical Reference Manual 
for Microsoft SQL Server Database Driver (U7366C US). 

This document contains the following chapters and appendices: 

Chapter 1, “Microsoft SQL Server installation,” lists the activities you must 
perform to install the Microsoft SQL Server. 

Chapter 2, “Baan ERP 5.0c installation,” describes how to install and 
configure the Baan ERP 5.0c software.  

Chapter 3, “Post-installation procedures,” provides recommended and 
optional post-installation procedures. 
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Appendix A, “To create manually the database for Baan ERP 5.0c,” 
describes how to do the following: 

� Use SQL Server to create manually a database for Baan ERP 5.0c. 

� Create Baan ERP 5.0c database users and groups. 

Appendix B, “Unattended installation of Baan ERP 5.0c,” describes how to 
perform an unattended installation or uninstallation of Baan ERP 5.0c. 

Send us your comments 
We continually review and improve our documentation. Any remarks/requests 
for information concerning this document or topic are appreciated. Please e-
mail your comments to kd@baan.com.  

In your e-mail, refer to the document number and title. More specific 
information will enable us to process feedback efficiently. 

 

mailto:kd@baan.com?subject=Documentation


 

This chapter describes how to install and configure the Microsoft SQL Server 
version 2000 software. This chapter covers the following topics: 

� Hardware and software requirements 

� Microsoft SQL Server installation 

� Test the SQL Server installation 

Important documentation: 

For more detailed technical information, refer to the SSA® Baan ERP 
Technical Reference Manual for Microsoft SQL Server Database Driver 
(U7366C US). 

For best results, before you continue with this manual, review the 
Deployment Guide for SSA® Baan ERP 5.0c (U8026C US) for more specific 
background information. 

Hardware and software requirements 

The Baan ERP 5.0c installer for Microsoft SQL Server supports the 
configuration in which both SQL Server and Baan ERP 5.0c are on the same 
server.  
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You can use various hardware configurations to install Baan ERP with 
MSSQL. To find the correct hardware equipment for your Baan 
implementation, you can request a sizing by Baan. You must think in 
advance about the use and redivision of the system. Undersized or oversized 
hardware can cause serious problems while you work with the Baan 
software. The following minimum hardware and software requirements apply 
for a system in which both SQL Server and Baan ERP 5.0c are installed on 
the same machine: 

To install SQL Server and Baan ERP 5.0c, your system must meet the 
following hardware and software requirements: 

� An Intel system with at least a Pentium processor 

� 64 MB of main memory (RAM) and 8 MB for each additional user 

� 64 MB of paging space (virtual memory) 

� Microsoft Windows 2000 Server with the latest Service Pack installed  

The latest Service Pack for Windows 2000 is available at the following link: 

http://www.microsoft.com/windows2000/downloads/servicepacks/default.asp 

� Microsoft Windows 2003 Server with the latest Service Pack installed  

The latest updates for Windows 2003 are available at the following link: 

http://www.microsoft.com/windowsserver2003/downloads/default.mspx 

� Microsoft SQL Server version 2000 (Enterprise or Standard Edition) or 
later 

� CD-ROM drive 

� Network adapter supported by Windows 2000: The network interface card 
must be installed and configured, but need not be connected to a network. 

Note  

For more information on how to set up your Windows 2000 server, refer to 
the Windows 2000 Installation Guide. 

Note 

Additional network software is not required because SQL Server runs on the 
Windows 2000 platform through the built-in network software. 

http://www.microsoft.com/windows2000/downloads/servicepacks/default.asp
http://www.microsoft.com/windowsserver2003/downloads/default.mspx
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Microsoft SQL Server installation 

To install the Microsoft SQL Server software, take the following steps: 

Note1 

Make sure that you have Microsoft SQL Server 2000 Standard Edition or 
Enterprise Edition. If you plan to install the Enterprise Edition, you must also 
have the Enterprise version of Windows 2000 installed. 

Note2 

For SQL Server 2000, you must use the latest Service Pack. The latest 
Service Pack for SQL Server 2000 is available at the following link: 

http://www.microsoft.com/sql/downloads/default.asp 

Note3 

When you install the SQL server on Windows 2000, run the appropriate 
setup through the Add/Remove Programs wizard in Control Panel. Take the 
following steps: 

1 Click Start, point to Settings, click Control Panel, and double-click 
Add/Remove Programs. 

2 Click Add New Programs. 

3 Click CD or Folder. 

4 Click Next. 

5 Go to the appropriate setup program or accept the setup program found and 
click Next. 

The set-up program now launches and you can start the installation 
procedure. 

The procedure to perform the installation process for Internet Explorer 
consists of the following steps: 

1 Log on as a user with administrator rights. 

2 Insert the Microsoft SQL Server distribution CD-ROM in the CD-ROM drive. 
The system automatically displays the SQL Server installation options. To run 
the autorun program manually, double-click Autorun.exe in the root folder of 
the SQL Server 2000 CD-ROM. 

http://www.microsoft.com/sql/downloads/default.asp
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3 Click SQL Server 2000 Components. The Install Components dialog box 
appears: 

 
4 Click Install Database Server. The Welcome dialog box appears.  

5 Click Next to continue.  
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The Computer Name dialog box appears.  

 
6 Click Local Computer and click Next. The Installation Selection dialog box 

appears. 
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7 Select Create a New Instance of SQL Server or Install Client Tools and 
click Next to continue. The User Information dialog box appears, which asks 
you asks you to enter the name and company of the person who will install 
the software to install the Microsoft SQL Server software for the first time.  

  
8 Type a user name and company name and click Next to continue. The 

License Agreement dialog box appears. 

9 Read the License Agreement thoroughly and, if you accept the terms of the 
agreement, click Yes. The CD-Key dialog box appears.  
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10 Enter your CD-key and click Next. The Installation Definition dialog box 
appears: 

 
11 Click Server and Client Tools and click Next.  
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The Instance Name dialog box appears:  

 
12 Select the Default check box for a default installation and click Next.  
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The Setup Type dialog box appears.  

 
13 Click Custom to specify a custom installation, because particular 

configuration requirements for Baan might not match the defaults in a typical 
or minimum installation. Note that you can browse and set the destination 
folders for the SQL Server program files and data files. 

14 Click Next to continue. The Select Components dialog box appears.  
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15 Accept the default configuration and click Next. The Services Accounts 
dialog box appears: 

 
16 Click Use the Same Account for Each Service. Auto start SQL Server 

Service, and in the Service Settings area, click Use the Local System 
Account in the Service Settings dialog box. 

Note 

You use the Use the Same Account for Each Service. Auto start SQL 
Server Service to start the SQL Server automatically at system startup. 

This completes the Baan-recommended selections. However, you can 
optionally also select Customize the Settings for Each Service. 

17 Click Next.  
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The Authentication Mode dialog box appears: 

 
18 Choose the authentication mode Mixed Mode and click Next.  



B-12 | Microsoft SQL Server installation 

 

The Collation Settings dialog box appears: 

  
A sort order is a set of rules that determines how SQL Server collates and 
presents data in response to database queries. You must select the correct 
sort order during the installation of SQL Server. If you must change sort 
orders after you install the SQL Server, you must rebuild your databases and 
reload your data. 

Note 

For more information about the various sort orders, refer to “Sort orders,” in 
the SQL Server Setup Help on the CD-ROM, or read Chapter 1 of the 
Microsoft Windows 2000 Server Installation Guide. 

19 Select the appropriate sort order. For Baan IV, you must select the Binary 
check box to use binary order.  

20 Click Next.  
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The Network Libraries dialog box appears:  

 
21 Make sure that the TCP/IP Sockets and Multi-Protocol check boxes are 

also selected. You can accept the default TCP/IP port number 1433. The 
Named Pipes protocol is selected automatically 

22 Click Next. 
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23 Click Next to start to copy the files. The Choose Licensing Method dialog 
box appears: 

  
24 Choose your preferred licensing mode and click Continue. 

25 Complete the licensing procedure and click Continue. If you require more 
information, click Help. In addition, if you click Per Seat For, be sure to enter 
the number of concurrent connections. 

Baan ERP now copies the files to the appropriate directories and displays a 
progress bar. In addition to the SQL Server 2000 software, the set-up 
procedure installs the Microsoft Data Access Components, Microsoft 
Management Console, and Microsoft Distributed Transaction Coordinator, 
among other components. 

26 Click Finish to complete the installation of Microsoft SQL Server 2000. 
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Test the SQL Server installation 

When the SQL Server installation is complete, to test the installation, you can 
connect to the server locally with the ISQL utility from the server. To test the 
SQL Server installation, take the following steps. 

1 Log on as a user with administrator rights. 

2 Click Start, point to Programs, and click Command Prompt. 

3 Enter the following command to connect to SQL Server: 

� C:\> isql /Usa /P 

4 Verify that the command displays the following prompt: 

� 1> 

This confirms that isql can connect to the database server. 

Note 

If isql cannot connect, the system displays a DB Library error. For more 
information, refer to the Microsoft SQL Server Troubleshooting Guide. 

5 Enter the following query to display the version of your MS SQL Server. 

� 1> select @@version 

� 2> go 

6 Verify that isql displays the server name, as shown in the following example: 

Microsoft SQL Server 2000 - 8.00.194 (Intel X86) 

 Aug  2000  00:57:48 

 Copyright (c) 1988-2000 Microsoft Corporation 

 Enterprise Edition on Windows NT 5.0 (Build 2195: Service 
Pack 2) 

(1 row affected) 

1> 

7 Enter the following command to return to the command prompt. 

� 1> exit 

This completes the SQL Server installation testing. 
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To tune SQL Server 

For optimal performance, take the following steps to tune SQL Server: 

1 Click Start, point to Programs, point to Microsoft SQL Server, click Query 
Analyzer, and click Windows Authentication. 

2 Type the following to enable the advanced options: 

EXECUTE sp_configure “show advanced options”, 1 

reconfigure with override 

3 Click Run Query to run the query. 

4 Set the following tuning parameter to disable the parallel query: 

EXECUTE sp_configure “max degree of parallelism”, 1 

5 Click Run Query to run the query. 

To further increase your system performance, note the following: 

To deploy SQL Server on a machine on which other applications are 
installed, you must accept the default value of 0 for Priority Boost. 

To deploy SQL Server on a dedicated machine, you must enable priority 
boost. Type the following: 

EXECUTE sp_configure “priority boost”,1 

To enable SQL Server fibers, type the following: 

EXECUTE sp_configure “lightweight pooling”,1 

The Max Worker Threads parameter has a default value of 255. Which 
value is adequate depends on your machine. To give an impression: a value 
of 125 can suffice for a machine with four CPUs, while a machine with two 
CPU’s can do with a value of 85. To set the parameter, type the following: 

EXECUTE sp_configure “max worker threads”,255 

Note 

The Max Worker Thread parameter is only accepted in multiples of two. 
Other values are rejected as “Not a valid value.” 
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The SQL Server sets the Open Objects parameter depending on the current 
needs of the system. In most cases, you do not have to change this value. To 
configure this parameter with the value 0, SQL Server automatically 
calculates which value is adequate. 

EXECUTE sp_configure “open objects", 0 

To carry out the query, click Run Query 

Another optional setting that can increase performance is to adjust the NT 
Global Environment settings. To make this adjustment, right-click My 
Computer, and on the shortcut menu, click Properties¾Advanced tab ¾ 
Environment Variables ¾ System Variables ¾ New and set the following: 

USERWEIGHT=2.0 

 6  Create of edit the Db_resource file. You can find this file in 
$BSE\lib\defaults\db_resource to include: 

� dbsinit:01 

� lock_retry:0 

� bdb_max_session_schedule:50 

The system is now ready for the Baan ERP installation. 
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This chapter provides the requirements and procedure to install 
Baan ERP 5.0c in the following sections: 

� Installation requirements 

� Baan ERP 5.0c installation procedure 

Installation requirements 

This section provides the following preinstallation information: 

� The hardware and software requirements 

� How to create the Windows 2000 user baan 

� How to enlarge the event log 

� The installation considerations 

Hardware and software requirements 

Before you install Baan ERP, verify that you have the following available: 

� Baan ERP 5.0c installation CD-ROM  

� Windows 2000 or Windows 2003, installed and running 
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� Microsoft SQL Server version 2000 installed and running, as described in 
Chapter 1, “Microsoft SQL Server installation.” 

� Approximately 3 GB of available disk space 

� One gigabyte of disk space during the installation of the Baan ERP 
application. Only about 550 MB is actually used once the installation is 
completed and all temporary installation files are removed. Note that you 
can only install Baan ERP on a local NTFS-formatted file system. 

� At least 2 GB of available disk space is required to accommodate the SQL 
Server data and log files for Baan ERP. A fully loaded database needs at 
least 800 MB for the tables and must have at least a 100 MB transaction 
log. Although these minimum sizes are sufficient to perform the initial 
installation, little additional space is available for new companies or data 
growth. 

� A network interface card installed and configured 

Create the Windows 2000 user baan 

To create the Windows 2000 user baan, take the following steps: 

1 Log on as a user with administrator rights. 

Note 

You must log on to the local server. 

2 Click Start, point to Programs, click Administrative Tools (Common), and 
click either User Manager or User Manager for Domains. 

3 Click New User on the User menu and add the user baan. 

Note 

You must initially create the user baan with the password baan. After you 
successfully install the Baan ERP software, you can change this password 
with the User Manager in Windows 2000 and the Database Administration 
sessions in Baan ERP. 

4 Click the Groups button and add the appropriate groups to user baan’s 
profile to make this user a member of the Users and Administrators groups. 
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Enlarge the event log 

Prior to the Baan ERP installation, you must enlarge the Windows 2000 
event log. To enlarge the event log, take the following steps: 

1 Select Event Viewer from the Administrative Tools (Common) program 
group. 

2 Right-click Application Log, and on the shortcut menu that appears, click 
Properties. The Application Properties dialog box appears.  

3 Make sure that the Change Settings For field specifies the Application 
Log: 

 
4 Change the setting in the Maximum Log Size field to 2048. 
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5 Click Overwrite Events as Needed. 

6 Click OK and close the Event Viewer window. 

Installation considerations 

What if your database exists before the Baan ERP installation? 
The Baan ERP installer enables you to create a new SQL Server database or 
specify the name of an existing SQL Server database to load the Baan ERP 
data. For best results, allow the Baan ERP installer to create the database for 
you. The Baan ERP installer enables you to create a database with one data 
file and one log file. If you have sophisticated database configuration 
requirements, you can create the database manually, for example, with SQL 
Enterprise Manager, and use that database name during the Baan ERP 
installation. Both methods are described in the following installation 
procedure. 

Multiple environment support 
Multiple Baan ERP installations, or environments, for each Windows system 
are supported in this release. 

You can change the password for user baan after the installation 
The Windows user baan must have the password baan while performing the 
Baan ERP installation. After you complete the Baan ERP installation, you can 
change the password for user baan with the Windows User Manager and the 
Database Users (ttdba0115m000) session in Baan ERP’s Database 
Administration (DBA) module. For more information, refer to the SSA® Baan 
ERP Administrator’s Guide (U7189 B US). 

Baan ERP 5.0c installation procedure 

To install Baan ERP, take the following steps: 

1 Close all running applications. 

2 Log on as user baan. 
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3 Insert the Baan ERP distribution CD-ROM in the CD-ROM drive. If autorun is 
enabled, the Welcome dialog box appears automatically: 

 
If you must perform a manual launch of the Baan installation program, 
choose Setup.exe in the I386 subdirectory of the Baan installation CD-ROM. 

4 Click Next. The Software License Agreement dialog box appears. 
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5 Read the license agreement thoroughly, and if you agree with the terms in 
the license agreement, click Yes to accept the license agreement. The 
Select Baan Software Environment dialog box appears: 

 
6 Click Install New Environment, enter a name for the environment, such as 

Baan ERP or some other unique name, and click Next.  
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The Choose Destination Location dialog box appears. 

Note 

The path that defines the destination location must not contain a space. 

 

To accept the default path or enter another path (not a root directory), you 
can click Browse. If the target directory does not exist, you are asked 
whether you want to create this directory. 

Do not enter a network drive as the target location of the Baan ERP files. The 
Baan ERP 5.0c services do not run from a network drive. 

7 Click Next.  
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The Setup Type dialog box appears: 

 
You can select one of the following options: 

� User Interface: The Baan Client, also called SSA® Baan Windows (BW). 

� User Interface and Logic: Referred to as the FAT client. The FAT client 
contains both the user interface and some application logic. The FAT 
client and can only be run on Windows 2000 or 2003. 

� Full (Including Application Files and Database): The complete 
Baan ERP 5.0c installation for Windows documented here. 

8 Select Full as the setup type and click Next.  
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The Enter Locale Settings dialog appears: 

 
9 Select your locale. In case of a U.S. English installation, you can click No 

Multibyte in the Multibyte Option field. The locale will be ISO-8859-1.  
To update your environment later with another language that requires 
multibyte, you must select Multibyte in Native Format now in the Multibyte 
Option field. The locale for US English will be the same.  

10 Click Next to continue.  
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Multibyte installation 
In case of a multibyte install you can choose one of the following locales: 

TSS_Locale in SSA® Baan ERP installer NLS Locale in BW 

BIG5_WIN32 Traditional Chinese (BIG5) 

GB2312_WIN32  Simplified Chinese (GB) 

KANJIEUC_WIN32  Japanese on Win32 platform 

SHIFTJIS_WIN32 Japanese (SJIS) 

WANSUNG_WIN32 Korean (WANSUNG) 
 
The Logic Service User Account dialog box appears: 

 

The note on the screen is self-explanatory.  

11 Click Next to continue.  
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The Select Database to Use dialog box appears: 

 
12 Select Microsoft SQL Server 2000 (the default) as the database to use and 

click Next.  
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The MS SQL Server Instance dialog box appears: 

 
SQL Server 2000 supports Multiple SQL Server Instances. This dialog box is 
only applicable for SQL Server 2000. Earlier versions do not support Multiple 
SQL Server Instances, which means that you can install Baan ERP 5.0c on 
one of the available SQL Server 2000 instances that are shown in this dialog 
box. 

13 Click Next.  
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The Baan User Password dialog box appears: 

 
14 Type baan and click Next.  
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The Baan Group Name and Password and SQL Server ‘sa’ Password 
dialog box appears: 

 
In the Group field, the default name is baandb, which is used as an example 
for the remainder of this installation procedure.  

Note 

Do not use the group name baan because this setting will cause a conflict 
with permissions in MSSQL2000. For best results, use baandb or another 
name. The installation will fail if you use the name baan as a group name 

Note 

The group name is the name of the SQL Server database and the password 
is used for the DBO login.  

CAUTION! The group name must be all lowercase and must not contain a 
space.  

� If a database is not yet created, accept the default group name or type in 
another group name according to the rules specified in the previous 
Caution statement. 
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� If a database is already created, type the database name in the group 
field.  

15 Type a password that you want to associate with the group in the Password 
field.  

16 Type the password for the SQL Server sa login in the sa field. If you have not 
yet assigned a password to sa, leave the sa field empty.  

17 Click Next to continue. The Set Database Driver Mode for the Installation 
dialog box appears: 

 
This dialog box is only applicable for SQL Server 2000. Baan ERP 5.0c is 
supported in both levels. Choose the appropriate mode for your installation. 
Note that Baan recommends that you choose level 2.  

18 Click Next. 

Note 

SQL Server 7.0 is supported only in level 1 mode. This dialog box will not 
appear if you try to install Baan ERP 5.0c on SQL Server 7.0. 

The Baan ERP application communicates with the database by means of a 
database-specific driver.  
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This driver translates application queries into (database) native SQL queries, 
therefore, the application is database-independent.  

Level 1 driver 
For all databases supported by the Baan software, a so-called Level 1 driver 
is available. Level 1 signifies that the Baan database driver splits complicated 
Baan SQL statements into simple queries for the database server in an 
optimal way. As a result, the Baan software, rather than the database, 
performs the SQL statement optimization. 

Level 2 driver 
A Level 2 driver receives all queries from the Baan Virtual machine and 
sends these queries almost directly to the database. If applicable, the driver 
adds a hint to the query for optimal execution by the database engine. 

If you want to use the Baan ERP installation to create a new database, 
proceed with Step 19. 

If the database is already created, a message appears that asks whether you 
want to use the existing database. Click Yes, and then proceed to 
“Installation completion,” later in this chapter.  

19 After a few moments, the Device Location and Sizes dialog box appears. If 
you want to change the directory paths for a file, click Browse and select an 
alternative path. Note that the recommended minimum values for the data 
and log files are 2000 MB and 200 MB respectively. The absolute minimums 
are 800 MB and 100 MB, respectively.  
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CAUTION! Do not enter negative numbers in the Size fields. 

Note  

Temp Device Location is not configurable for Microsoft SQL Server 2000. 

Note  

For performance reasons, make sure to configure the data and log files on 
separate drives. 

20 Click Next after you complete your entries.  
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The Truncate Log on Checkpoint dialog box appears. The default for the 
Set Truncate Log on Checkpoint option ensures that production database 
recoverability is maintained. You must only select this option in situations 
where regular backups are not required and where the transaction log file 
must be cleared on a regular basis, such as a demo or training system. 

 
21 Select or clear the check box and click Next. Proceed to the following 

section, “Installation completion.” 
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Installation completion 

1 After you finish specifying the settings in the Truncate Log on Checkpoint 
dialog box, or if you chose to use an existing database in the Baan Group 
Name and Password and the SQL Server ‘sa’ Password dialog box, the 
Select Program Folder dialog box appears: 

 
2 Type the program folder name for Baan ERP 5.0c, which by default is Baan 

ERP, and click Next. The Setup Information dialog box appears.  

The Setup Information dialog box shows the setup selections you made in 
the previous steps.  

3 Review the setup selections. To change one or more of the previously 
selected settings, click Back  

Note 

If you choose to use an existing database during the Baan ERP 5.0c 
installation, some settings in this dialog box can be incorrect, which is normal. 
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4 Click Next when all the selections are correct to accept the selections and 
start the file copy process. If you chose to have the installer create the 
database, a message appears that informs you that the setup is creating the 
database. This process can take a few minutes. After the import is complete, 
a message appears that informs you that setup is complete.  

Note 

If the database import fails, you can manually import the database. For more 
information, refer to Appendix B.  

5 Click OK. This completes the Baan ERP installation procedure.  

6 Go to Chapter 3, “Post-installation procedures” to complete all remaining 
installation tasks. 



 

After you install both the database and Baan ERP, you must perform several 
additional tasks. Some tasks are also left to the discretion of the 
administrator. 

Recommended procedures 

The recommended post-installation procedures are the following: 

� Install the Baan Windows (BW) Client 

� Apply the license for Baan ERP. 

� Set up the demo tables 

� Configure shared memory. 

To install the Baan Windows (BW) Client  

Insert the Baan Master Distribution CD-ROM in the client’s CD-ROM drive. 
For more detailed information, refer to the Baan Windows (BW) Guide 
(U8398A US). 

3
Chapter 3                                                   
Post-installation procedures 
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To apply the license for Baan ERP 

This procedure assumes that the following data is already confirmed with 
Baan: 

� Customer number 

� License code 

� Sequence number 

� License start and end dates 

� Number of light and heavy users 

� Authorized database 

� Other authorized commercial functions 

Baan sends this confirmed information to the Baan customer as part of the 
Baan ERP ordering process. You cannot start the post-installation procedure 
without this data. 

Note 

You can find all the sessions in this section in the Software Installation folder 
in Baan ERP Tools. 

To request a validation key from Baan 
To request a validation key from Baan, take the following steps: 

1 Log on as user baan. 

2 Start Baan ERP. On the Menu Browser, on the File menu, click Run 
Program.  

3 Type ttiex3101m000 in the Program/Session field and click OK. You are 
asked to supply a password.  

4 Enter the default password Yi984. Do not make the default password 
available to unauthorized personnel. The Requested System Configuration 
(ttiex3101m000) session appears. 

5 Click New on the Group menu. 

6 Enter the start date in the From Date field and press TAB.  

7 Enter the end date of your license in the End Date field. Use the date format 
selected for your system.  
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8 Press TAB again and enter the number of light and heavy users as confirmed 
with Baan. 

9 Select the Runable check box that corresponds to the supported database, 
which is the RDBMS on which the Baan ERP installation is running. Select 
the Runable check box for any other licensed parts, as well: 

 
Note 

Select MSQL Server 7 if you have installed MSQL 2000. 

10 Save and exit the session. 

11 On the Menu Browser, on the File menu, click Run Program.  

12 Type ttiex3400m000 in the Program/Session field and click OK. You are 
asked to supply a password.  

13 Enter the default password Yi984. Do not make this default password 
available to unauthorized personnel.  
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The Print Requested System Configuration (ttiex3400m000) session 
appears: 

 
14 Supply the requested information and click Continue. The Select Device 

session starts.  

15 Select a printer and click Continue. If your Baan printer configuration is not 
yet set up, print to a file that can be printed by another device. 

16 Send this printout to Baan, who will then send you the validation key. After 
you receive the key, you can proceed to the following section, “To complete 
system validation,” to complete the validation process. 

To complete system validation 
When you receive the validation key from Baan, take the following steps: 

1 Log on as user baan. 

2 Start Baan ERP.  

3 On the Menu Browser, on the File menu, click Run Program.  

4 Type ttiex3102m000 in the Program/Session field and click OK. A message 
appears that asks you to supply a password.  

5 Enter the default password Yi984. Do not make this default password 
available to unauthorized individuals. The Security Code/Validation Key 
(ttiex3102m000) session appears. 
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6 Fill in the Validation Key (Tools) field and the Validation Key Software 
(Standard) field. Make sure the security key matches the security key on the 
Baan printout. 

 
7 Save and exit the session.  

8 Start the Validate Tools Set (ttiex3220m000) session.  

9 Click Continue. If the validation process succeeds, the following message 
appears: 

 
 

10 Click OK. Read the warning message that appears.  

11 Click Close. Start the Configure Application (ttiex3225m000) session.  

12 Click Continue. A prompt indicates that the license daemon is not active.  

13 Click OK. You are asked if you want to start the license daemon.  

14 Click Yes.  

15 Click Continue to patch the objects. 

If the session is successfully completed you can close the session. 

Note 

If an error message appears when you start the license daemon, repeat 
Steps 11 through 14 until the validation is successfully completed. 

This completes the validation process. 
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To set up the demo tables 

This section describes the procedure to do the following: 

� Install demo tables 

� Initialize parameters 

To install demo tables 
You can install all tables from demo companies that are provided with the 
Baan ERP installation. The installer must decide which companies to install. 
However you must perform Steps 1 through 6 for company 000. Company 
000 is not a demo company, however, this company contains important data 
for the Baan ERP environment. 

To install the demo tables, take the following steps: 

1 On the Menu Browser, on the File menu, click Run Program. 

2 Type ttiex1290m000 in the Program/Session field.  

3 Click OK. The Install Demo Tables (ttiex1290m000) session appears.  

4 Click the browse arrow for the From and To fields to select the range of 
demo companies you want to use: 

 
5 Select the Overwrite Existing Tables check box. 
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6 Click Install. The demo tables are installed. During the installation the cursor 
changes into an hourglass. When the cursor changes back to its original 
appearance, the installation is complete.  

7 Click Close. To install the remaining empty tables, you can continue with the 
section “To create the remaining tables”  

To initialize parameters 
To initialize the parameters, take the following steps: 

1 Log on as user baan and switch to one of the demo companies you installed.  

2 To switch to another company, on the Options menu, click Change 
Company.  

3 Click Run Program on the File menu and type tcmcs0295m000.  

4 Click OK. The Initialize Parameters (tcmcs0295m000) session appears:  

  
5 Click Continue.  

6 Repeat Step 1 and Step 3 for the rest of the installed demo companies. 

To configure shared memory 

To improve application performance, you can store frequently used data 
objects in shared memory where all running Baan ERP processes can 
access them. The process to configure shared memory has two steps, to 
specify which objects must be stored in shared memory, and to configure the 
Baan Shared Memory service. 
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To specify objects stored in shared memory 
To specify which objects are stored in shared memory, take the following 
steps: 

1 Start Baan ERP: on the Menu Browser, on the File menu, click Run 
Program.  

2 Type ttaad4150m000 in the Program/Session field.  

3 Click OK. The Shared Memory Data (ttaad4150m000) session appears: 

 
4 On the Group menu, click Find.  
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In the Shared Memory Data Type list, click Program Objects: 

 
5 Click Copy Object from DD on the Specific menu. The Copy Program 

Objects (ttaad4252s000) session starts.  

6 Enter tt in the Package field and select the version with the Version field’s 
Zoom icon.  

7 In the Program fields, enter dll in the From field and dllzzzzzzzzz in the To 
field and click Copy: 

 
8 Click OK in the dialog box that appears. The Shared Memory Data 

(ttaad4150m000) session appears again, now filled with data. 

9 Repeat Steps 4 through 6 for the programs dsk to dskzzzzzzzzz and stp to 
stpzzzzzzzzz. 



B-10 | Post-installation procedures 

 

10 Click Convert to Runtime on the Specific menu.  

11 Click OK at the prompt when the conversion is complete and close the 
session. 

12 Open the Baan MMC NT Manager.  

13 Right-click Shared Memory Service, and on the shortcut menu that appears, 
click Stop service. Next, right-click again and click Start service on the 
shortcut menu. 

To configure the Baan Shared Memory service 
To configure the Baan Shared Memory service, take the following steps:  

1 Click Start, point to Programs, click Baan ERP, and click Baan MMC NT 
Manager. The Baan MMC NT Manager dialog box appears  

2 Select your Server icon and open the Environment icon. To configure the 
shared memory, right-click BaanSharedMemory and click Properties. 
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The Shared Memory Configuration dialog box appears:  

  
3 Review the settings listed, and if the settings are appropriate, click Close and 

skip the remaining steps in this section.  

Otherwise, review and update any of the following options:  

� Start address: 
Can be either 0x20000000 or 0x7FFEFFFF. 

� Maximum Size (MB): 
This setting defines the maximum amount of shared memory, from 1 MB 
to 2015 MB, allocated for Baan ERP applications. Note that if the Baan 
ERP applications need less than the amount defined in this field, the rest 
of the reserved shared memory is released as unshared memory. 
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� Load Shared Memory at Startup: 
Select this check box to load shared memory at system startup. 

� Load as User: 
Accept the default user baan. This defines the user account that is used 
to load shared memory. 

� Diagnostic options: 
Select Show all Messages, Show Errors Only, or Silent. You can view 
the messages with the Baan ERP Shared Memory Manager. 

� Maintain shared memory timer 
The shared memory server updates the shared memory timer if you select 
this option. 

4 Click OK after you reconfigure shared memory to accept the changes, then 
click Close on the Shared Memory Manager screen. You return to the BAAN 
MMC NT Manager menu. 

5 Right-click BaanSharedMemory, and on the shortcut menu that appears, 
click Stop service to stop the Shared Memory Service. 

6 Right-click Shared Memory Service, and on the shortcut menu, click Start 
Service to start the shared memory service. 

Optional procedures 

Several post-installation procedures are available that can be performed at 
the discretion of the administrator, including the following: 

� Create the remaining tables. 

� Configure the protocol in the Baan Logic Service. 

� Install the Implementation Master Data (IMD) model. 

� Uninstall the Baan ERP software. 

To create the remaining tables 

This section describes how to do the following: 

� Create the remaining tables. 

� Reorganize tables. 
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To create the remaining tables  
The demo table installation only creates tables that contain data. You must 
now create tables that are not yet created.  

To create these tables, take the following steps: 

1 On the Menu Browser, click Run Program on the File menu.  

2 Type ttaad4230m000 in the Program/Session field.  

3 Click OK. The Create Tables (ttaad4230m000) session appears: 

  
4 Type the company number in the From and To fields. To select the company 

numbers, you can click the browse arrows, however, you must only select 
those demo companies that you previously installed. 

5 Click Create. The Select Device dialog box appears.  
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6 Click the Device field’s browse arrow to display and select the device where 
you want the messages to appear. For example, the value D has messages 
printed to the screen.  

7 Click Continue.  

8 Click Close when the tables are created. 
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To configure the protocol in the Baan Logic Service 

The Baan Logic Service is automatically installed and started after the Baan 
ERP 5.0c installation. If you want to configure the protocol in the Baan Logic 
Service, take the following steps: 

1 Start the Baan MMC NT Manager and open your Server icon. 

2 Right-click the BaanLogicService icon: 

 
3 Click Stop Service on the shortcut menu. 

You must stop the Baan Logic Service before you configure the protocol. The 
system displays a message that the logic service is stopped. 

The Baan Logic Service offers you the following methods to connect to the 
Baan server: 

� Rexec: The standard remote execution protocol. Rexec does not use 
password encryption. 

� Baan login: Encrypts the users’ Baan passwords. 

� Security Support Provider Interface (SSPI): Only available on Windows. 
SSPI. Enables single-sign-on (SSO) for Baan ERP 5.0c. 
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If you work in a local area network, Baan ERP assumes you use Rexec. See 
the following example. 

4 Right-click the BaanLogicService icon, and on the shortcut menu, click 
Propertiestocol. If you click Rexec, you can enable the Named Pipe 
protocol: 

5 Click OK. 

6 Right-click the BaanLogicService icon and, on the shortcut menu, click Start 
service. 

This starts the Baan Logic Service. 
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To install the Implementation Master Data (IMD) model 

The implementation master data model is a project model that guides you 
through the setup of the master data of the various Baan ERP 5.0c 
packages. Before you start with this procedure you must install the demo 
tables. 

Note 

The user who carries out the DEM version import must have a default text 
groups template selected in the User Data (ttaad2500m000) session. 

1 Create a new system account imd.  

2 Log on to Baan. If the operating system of your Baan ERP 5.0c server is 
UNIX, you must log on as user bsp, on Windows 2000 you must log on as 
user baan. 

3 Click Run Program on the File menu and, in the Program/Session field, 
type ttaad2500m000. The User Data (ttadv2500m000) session starts. If the 
operating system of your Baan ERP server is Windows 2000, you must select 
user bsp and copy this user to user imd.  

On both UNIX and NT you must select user imd and double-click this record 
to define the following user data: 

� System Login: imd 

� Company: 902 
The demo company that contains the IMD model data 

� Startup Program: DEM Browser 
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In addition, you can adjust this user’s authorizations  

4 Return to the User Data (ttaad2500m000) session, select user imd, and on 
the Specific menu, click Convert BAAN User to Database User.  

5 Reselect user imd and, on the Specific menu, click Convert BAAN User to 
Runtime DD. Click Convert. 

6 On the Menu Browser, on the File menu, click Run Program.  

7 Type tgbrg1245m000 in the Program/Session field.  

8 Click OK. The Import Version Dump (tgbrg1245m000) session appears. 
Enter the import file in the following location: 

� Windows:  
C:\<$BSE>\test\IMD_B50c.dem.Z  

9 Select Overwrite, Check Data Integrity, and Print Errors.  

10 Click Import.  

11 Select a device to print the error report.  

12 Click Yes in response to the question “Import Components from Version 
IMD_B50c?” The version dump is imported and errors are printed in the 
report.  

13 Click No in response to the question of whether you want to “Change the 
Current Modeling Version to IMD_B50c?” 

14 On the Menu Browser, on the File menu, click Run Program.  

15 Type tgbrg1110m000 in the Program/Session field and click OK. The 
Current Modeling Version by User (tgbrg1110m000) session starts.  

16 Click Find and enter imd.  

17 Set the current modeling version to IMD_B50c.  

18 On the Menu Browser, on the File menu, click Run Program.  

19 Type tgbrg5157m000 in the Program/Session field.  

20 Click OK. The Components (tgbrg5157m000) session appears.  

21 Check whether the BaanERP component, component release B50c is already 
installed. If the component is not installed, create the component with the 
following steps: 

� Click New to create a new component.  

� Enter the component BaanERP. 
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� Enter the component release B50_c.  

� Enter the description BaanERP 5.0c.  

� Skip the Component icon and enter the component type BaanERP 5.0c. 

� Enter client/server Server. 
� Click Save.  

22 On the Menu Browser, on the File menu, click Run Program. 

23 Type tgbrg0135s000 in the Program/Session field. 

24 Click OK.  

25 Enter the password BAAN (use capitals). The DEM Parameters 
(tgbrg0135s000) session appears. 

26 Change the component to BaanERP. 

27 Change the Component Release to B50_c. 

28 Click Save. 

29 On the Menu Browser, on the File menu, click Run Program.  

30 Type tgbrg8135m000 in the Program/Session field.  

31 Click OK. The Employees (tgbrg8135m000) session appears: 

 
32 Double-click the imd employee and make sure that BAAN User is imd: 

If the component was not available in Step 21, take the following steps:  

� Go back to the Components (tgbrg5157m000) session. 
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� Select the BaanERP component and select Applications by 
Component. 

� The Applications by Component (tgbrg5155m000) appears. 

� On the Specific menu, click Import Applications from Running Baan 
Component. 

� The Import Applications from Running Baan Component (tgbrg5255m000) 
session appears.  

� Click Fill  
� Close all component sessions.  

The IMD model is now installed. You can login as user imd. If the installation 
was successful, Baan starts with the IMD model in the Dynamic Menu 
Browser. 

Service Pack installation 

Install the Service Packs. You can use the Batch installer to install the 
Service Packs in one run. For more specific information about the Batch 
Installer, refer to the Installation Guide for SSA® Baan ERP 5.0c SP3-13 
Batch Install Solution (U8325A US). For best results, after you finish with the 
Service Packs installation, run the Reorganize Tables (ttaad4225m000) 
session. You can encounter problems when you reorganize the tables before 
the installation of the Service Packs. 
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To reorganize tables 

The bdbpost utility, which you can use to install the demo tables, can disable 
referential integrity checking. To correct this error, you must reorganize the 
demo tables. Take the following steps: 

1 Click Run Program on the File menu and type the session code 
ttaad4225m000.  

2 Click OK.  

The Reorganize Tables (ttaad4225m000) session appears.  

 
3 Update the Company From and To fields with the range of demo companies 

you originally installed. In addition, select the options you want to use: 

4 Click Reorganize. 

5 Click Close in the Reorganize Tables (ttaad4225m000) session.  
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To uninstall Baan ERP 5.0c software 

If an installation failure occurs, take the following steps: 

1 Start the Baan MMC NT Manager and open your Server icon: 

 
2 To uninstall all existing Baan environments, right-click BaanLogicService, 

and on the shortcut menu that appears, click Stop Service. 

3 To uninstall all existing Baan environments, right-click BaanLogicService, 
and on the shortcut menu that appears, click Remove the Service. 

4 To uninstall all existing Baan environments, right-click BaanLicensing, and 
on the shortcut menu that appears, click Stop Service. 

5 To uninstall all existing Baan environments, right-click BaanLicensing, and, 
on the shortcut menu, click Remove the service.  

6 Right-click the BaanSharedMemory for the environments you want to 
uninstall and click Stop service. 

7 Right-click the BaanShared Memory for the environments you want to 
uninstall and click Remove the Service. 

8 Launch the uninstall program: Click Start, point to Programs, click 
BaanERP, and click Uninstall Baan. The Baan Uninstall screen appears. 
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9 Click Next. The Select Environment dialog box appears. 

10 Select the environment to be removed. 

11 Click Next. The Uninstall Options dialog box appears. You can choose to 
remove the Baan database for the environment you selected on the previous 
dialog box. You can be prompted for a password when you remove a 
database.  

12 Click Next. The Confirm Uninstall dialog box appears.  

13 Check the settings list.  

14 Click Next to continue or click Back to change any options. 

15 Respond to all the subsequent prompts, as necessary. 

16 Click OK when the uninstallation is complete. 

 

 

 

 

 





 

This appendix describes how to manually create the Microsoft SQL Server 
database files, logins and roles for Baan ERP. 

Note 

The Baan ERP installer enables you to create a new SQL Server database or 
specify the name of an existing SQL Server database to load the Baan ERP 
data. For best results, allow the Baan ERP installer to create the database for 
you. The Baan ERP installer enables you to create a database with one data 
file and one log file. If you have more sophisticated database configuration 
requirements, you can create the database manually, for example, with SQL 
Enterprise Manager, and use that database name during the Baan ERP 
installation. The procedure to manually create SQL Server a database for 
Baan ERP is described here. 

If you choose to create the database manually, take the following steps: 

1 Create the SQL Server database for Baan ERP. 

2 Create the Baan ERP database users and group. 

A 
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To create a database for Baan ERP 

A SQL Server database consists of the following database files. 

� One or more files for data: 
In the following example, the data file is called baandb_Data. SQL 
Enterprise Manager adds an .mdf extension to the file name. The size of 
this data file must be at least 800 MB. A data file of at least 2,000 MB is 
recommended to accommodate growth, or you can use SQL Server’s 
AutoGrow feature. In this example, a data file of 2000 MB is created. 

� One or more files for the transaction log: 
In the following example, the log file is called baandb_Log. SQL 
Enterprise Manager adds an .ldf extension to the file name. The size of 
this log file must be at least 100 MB (200 MB recommended). In this 
example, a log file of 200 MB is created. 

This section describes how to use SQL Enterprise Manager to create a 
database called baandb for the Baan ERP data. 
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To create the database, take the following steps: 

1 Click Start, point to Programs ¾ Microsoft SQL Server 2000 ¾ SQL 
Enterprise Manager. 

2 Right-click the Server icon, and on the shortcut menu, click Start to start the 
SQL Server, if required: 

 
3 Right-click Databases, and on the shortcut menu, click New Database. 
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4 Enter a database name on the General tab. 
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5 Click the Data Files tab: 

 
6 Enter an initial size and location for the data file. You can configure one or 

more data files for the database in this dialog box. 

The combined size of the data files must be at least 800 MB. 

7 Click the Transaction Log tab. 
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8 Enter an initial size and location for the transaction log file. You can configure 
one or more files for the transaction log in this dialog. 

The combined size of the log files must be at least 100 MB. 

 
9 Click OK. SQL Enterprise Manager creates the new database. This 

procedure can take some time. The database creation process takes longer 
as the data and log file sizes increase. 
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To create the database owner login, baan user login and SQL 
Server role 

To create the Baan ERP database users and role on the MS SQL Server, 
take the following steps: 

1 If you are not yet running SQL Enterprise Manager, on the Start menu, point 
to Programs, click Microsoft SQL Server 2000, and click SQL Enterprise 
Manager. 

2 Click the New Login icon on the toolbar. 

3 Enter the database name as the name of the new user. The user name must 
be the same as the Baan ERP database name. In our example installation, 
this login name is baandb: 

  
4 Click SQL Server Authentication and enter the user password. 
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5 Click OK. The system asks you to confirm the password: 

  
6 Enter the password and click OK. 

7 Choose Tools and SQL Server Query Analyzer. 

 
8 Choose baandb from the DB list. 

9 Type the following query to make baandb the owner (DBO) of the baandb 
database: 

� sp_changedbowner baandb, baandb 

10 Press CTRL+E or click Execute on the toolbar to carry out the query.  

11 Click New on the toolbar or menu to create a new database role. Type the 
following query to add the groupSQL Server role for Baan ERP. In our 
example installation the new role is called baandbg. 
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Note 

The SQL Server role name derives from adding the character g to the 
database name. In this example for database baandb, the role name is then 
baandbg. 

� sp_addrole baandbg 

Press CTRL+E or click Execute on the toolbar to carry out the query. 

12 Select File and Exit and click No to discard the text in the window. 

13 Right-click the server, and on the shortcut menu, click Refresh in the main 
window of the Enterprise Manager. 

14 Click the New Login icon on the toolbar to create a database user: 

  
15 Enter the logon name for the new user. In this example, the name baan is 

used. 

16 Select SQL Server authentication and enter the user password. 
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17 Click OK. The system asks you to confirm the password.  

  
18 Type the password and click OK. 

19 Click the Database Access tab: 

  
20 Select the Permit check box that corresponds to the baandb database to 

assign the baan user permission on the database. 

21 Select the check box that corresponds to baandbg in the Database Roles 
area to give the user permissions on the Baan ERP tables in the database. 
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22 Click OK to confirm. 

23 Confirm the password. 

24 Exit the SQL Enterprise Manager. 
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This appendix describes the prerequisites for an unattended installation and 
uninstallation of Baan ERP BackOffice. The first part of this appendix 
describes the unattended installations or uninstallations with Microsoft 
System Management Server (SMS). SMS is a system management 
environment for corporate networks, which consists of one or more LANs. 
SMS enables users to distribute software across one or more LANs, among 
other procedures. SMS itself is not discussed in this appendix. For a 
description of SMS, refer to the Microsoft System Management Server 
Administrator’s Guide. 

The remaining part of this appendix describes unattended installations or 
uninstallations of Baan ERP with InstallShield response files. 

Prerequisites for an unattended installation 

Before you can perform an unattended installation, your system must meet 
the following conditions: 

� During the installation of Microsoft SQL Server, the binary sort order must 
be selected. Refer to Chapter 1, " Microsoft SQL Server installation," for a 
description of how to select the sort order. 

� For an unattended Baan ERP database server setup, the used database 
environment must be clean. Do not use an old database environment. 

B 
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� The default drive used is the C: drive. This drive must contain sufficient 
disk space to hold the required Baan ERP installation. 

� To perform an unattended install of the Baan ERP Back Office software, 
the user must be logged on as user baan on the workstation where the 
package is sent. This account must have administrator rights, as 
described in “To add the Windows user baan,” in Chapter 2, "Baan ERP 
5.0c installation." If you are logged on as another account, the unattended 
installation is ended. 

To import the Baan package definition file into SMS 

SMS uses package definition files, with the extension .pdf, that specify setup 
programs, installation options, and execution command lines for applications. 
For Baan ERP Back Office the definition file Baan.pdf is used. To import the 
Baan package definition file into SMS, take the following steps: 

1 Start the Microsoft SMS Administrator 

2 Click the Open Window: packages toolbar button. 

3 On the File menu, click New. The Package Properties dialog box appears: 

  
4 Click Import. 

5 Select the disk on which the Baan ERP installation CD-ROM is located and 
then select the SMS directory. 

6 Select the Baan.pdf file and click OK. 

7 Click Workstations in the Package Properties dialog box. The Setup 
Package for Workstations dialog box appears. 
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8 Set the source directory to the root of the Baan ERP installation CD-ROM, for 
example, d:\. 

9 Click Close. 

10 Click OK in the Package Properties dialog box. 

The Baan ERP BackOffice unattended setup files 

The following unattended installations or uninstallations of Baan ERP are 
supported in the standard Baan.pdf file: 

� Full installation on SQL Server to the C: drive: file SQLServer.iss in the 
SMS directory on the Baan Installation CD-ROM. 

� Uninstall full installation on SQL Server: UnSQLSrv.iss 

� User interface installation to the C: drive: Bw.iss 

� User interface and logic installation to the C: drive: Bshell.iss 

� Uninstall user interface: Unbw.iss 

� Uninstall user interface and logic: Unbshell.iss 

To support installations other than these default installations, you can adjust 
the Baan.pdf file, create you own response files (as described in the following 
chapter), and reimport the Baan ERP package. 

To create an InstallShield response file 

The InstallShield Response files are used both by SMS to perform 
unattended installations and uninstallations by the Baan Installation program 
to perform an installation without any user interaction. 

To create your own InstallShield response file, take the following steps: 

1 Start the installation program 

2 Enter the required input and complete the installation or uninstallation 
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An InstallShield response file is now written to the Windows temporary 
directory, with the name Setup.iss, for example, c:\temp\setup.iss. Give this 
file a meaningful name and save the file in another location, for example, 
c:\baaninstalls\BwInstall.iss. 

To perform a silent Baan ERP installation or uninstallation 

A silent Baan ERP installation or uninstallation is an installation for which no 
user interaction is required. 

To perform a silent Baan ERP installation or uninstallation, take the following 
steps: 

1 Start a command prompt: 
For a Baan ERP installation change directory to the Baan ERP installation 
CD-ROM and then go to the I386 directory, for Intel machines. For an 
uninstallation, change the working directory to c:\winnt\baan\uninst. 

2 Start the set-up program as follows: 

� setup.exe –s [–funsetup.ins] –fresponse file 

The –funsetup.iss option is only required if you want to perform an 
uninstallation. The response file parameter specifies where the response file 
is located. Note that no space exists between the –f option and the response 
file location. 

For example, to perform a silent installation with the 
c:\baaninstall\BwInstalls.iss response file, use the following command: 
setup.exe –s –fc:\baaninstalls\BwInstalls.iss 
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